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ABOUT SANAKO STUDY

STUDY APPLICATIONS

SanakKo

SANAKO STUDY TUTOR APPLICATION

Teachers use the Study Tutor application, which is the main
interface to the Study system. The Tutor application allows
teachers to instruct with the Study system and to control the
classroom computers.

SANAKO STUDY STUDENT APPLICATION

The Study Student application is installed onto all student
computers. Study Student connects to Study Server at
system startup and runs in the background listening for
commands from Study Tutor. Students can open the student
interface to work independently, however, teachers are able
to control student computers, regardless of whether the
Student application is visible on student screens or not.

SANAKO STUDY SERVER

The Study Server application is the information center of the
Sanako Study system and both the Tutor and Student
components automatically connect to it. All system data is
passed through Study Server and it allows communication
between the Tutor and Student components.

We recommend using classroom specific server computers,
commonly the teacher computer in each class, with
individual classroom names.

However, you may also use a shared license server for
multiple classrooms. Please note that in this case the shared
license server must be running in order to use any of the
classrooms.
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STUDY LICENSES

Instead of a printed product license, Sanako Study
customers receive a license activation token by email. The
token is entered during Study Server software installation to
activate the software license. However, the activation
process requires that you have an active Internet connection.

In order to use license tokens customers need to register
and create a user account on the Sanako registration portal.
This can be done either during the installation or beforehand.
Once you have completed the registration process, you will
receive your user account information by email. The address
for the registration portal is:

http://registration.sanako.com/tokens/en-
US/Account/Reqgistration

In case the computer where you are installing Study Server
software does not have an Internet connection, you may
complete an alternative offline activation process in order to
finalize your installation.

STUDY CLASSROOMS

4 -

Sanako Study uses virtual ‘classrooms’ to bring together
both teacher and student computers into the same learning
space. Each teacher and student computer is assigned a
‘classroom name’ during installation. When teachers begin a
learning session, they will get to select which student
computers to include from all the computers in their
‘classroom’.
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REQUIREMENTS

AS PER THE REQUIREMENTS FOR THE MICROSOFT®
WINDOWS® XP, WINDOWS VISTA OR WINDOWS 7
OPERATING SYSTEM

SanakKo

Microsoft® Windows® XP, Windows Vista or Windows
7 operating system

Microsoft .NET Framework® 2.0 SP2, Microsoft .NET
Framework 3.0 SP2 or Microsoft .NET Framework 3.5
SP1

DirectX 9.0c or higher
1.5 GHz processor

1 GB of system memory, 2 GB recommended for
Tutor PC

100 MB of free disk space for installation *
1024*768 display resolution with 16-bit colors
AC97 or HDA compatible sound card
Network Adapter, TCP/IP support required

PC Headset — recommended Sanako models to
ensure high quality audio

QuickTime® 7.0.3 or later is required for displaying
certain file types and for the Sanako Study Video Live
Module

Internet access during Server component installation**

*) The amount of free disk space required during the use of Study 1200
varies primarily according to the use of the recording functionality - longer
recording times require more disk space.

**) |If there is no Internet connection on the Server computer, you may
perform an offline activation process. Instructions for offline can be found
later in this guide.
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Note: In order to use the OneNote feature, Microsoft
OneNote must be installed on the student computers before
installing Study Student. Otherwise Study will be unable to
connect to OneNote and tutor notes cannot be sent to
students’ OneNote applications.

Note: Actual requirements may vary based on your system
configuration. It is essential to make sure that the operating
system runs smoothly on each computer where a Study
Tutor or Student application will be installed.

NETWORK REQUIREMENTS

6 -

The following requirements should be met by the network.
Multicast must be enabled in the network.

All computers must be in the same TCP/IP sub-net in
order to allow multicast transfer of screen and audio to
students

It is recommended that all workstations within a room
are connected to the same network switch with
support for multicast transmission

Student and teacher workstations need to be able to
PING each other and the Study Server with TCP/IP
packets

If the computers have multiple network adapters, the
adapter used by Sanako Study must be bound first,
because Windows operating systems send multicast
data to the first adapter

In LAN minimum of 100B bandwidth or greater
dedicated to each workstation. For WLAN
implementations, please refer to the Sanako WLAN
Deployment Guide found on the installation DVD for
requirements and suitable wireless hardware

For optimum performance in file operations, we
recommend using a file server for storing media files
and collected student recordings. However, the
teacher computer may be used for file operations if a
separate file server is not available.

o Teacher and students should have unrestricted
access to the server

0 Schools may use an existing server with Linux,
Windows NT or Windows Server operating
system

0 A NAS (Network Attached Storage) server may
also be used

Sanako Study v. 5.50 Technical Guide SanakKko



o0 Note: Windows XP, Windows Vista and
Windows 7 operating systems do not support
sharing a folder for over 10 simultaneous users
and therefore cannot be recommended as file
servers

FIREWALL SETTINGS

Sanako Study adds required Windows firewall exceptions
automatically during installation.

If a non-Windows firewall is used please verify that the
following programs have been added to the firewall
exceptions list.
- Tutor.exe (Tutor computer)
Student.exe (Student computers)
StudyServer.exe (on computer with Study Server
software)

The default TCP ports used by Sanako are:
Port 5060 for audio packets
Port 15525 for screen packets
Port 15535 for remote control data
Ports 6310, 6311 and 6312 for Study Server
operations

NOTES ON DISK SPACE

SanakKo

The amount of hard disk space required for the storage of
digitized files depends on how much material will be made
available to the students at any one time and how much work
the students are likely to save to their own area. Disk quota
sizes usually vary between 20 and 50MB per student.
However, students using Study 1200 typically require a disk
guota of 100MB minimum to allow them to save work during
class for self-study reinforcement.

A typical MP3 audio file size (default setting in Study 1200) is
approximately 1MB per minute.

Therefore, a typical 160GB hard disk drive would allow for
the saving of approximately 2600 hours of audio.

In order to ensure that this information can be delivered to all
the student desktops simultaneously (i.e. smooth video and
audio playback) Sanako strongly recommends the use of
hardware RAID controllers on the server or the use of
Network Attached Storage (NAS) devices.

Sanako also recommends that you take regular data back-
ups. The use of a CD/DVD writer is also recommended to
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save student oral recordings and/or source material that are
infrequently used. When this material is required it can be
copied to the server from the CD archive.

8 - Sanako Study v. 5.50 Technical Guide SanakKo-+



INSTALLATION

At the time of installation, the installer needs to have Local
Administrator user rights. Please note that in some
configurations, Domain Administrator rights are not enough
to install applications.

Computers where Study is installed must have a suitable
way to access Sanako installation media. This can be e.g. a
DVD-drive, a USB port which supports USB memory keys or
access to a network location where Study installation files
are placed.

SOFTWARE COMPONENTS

The following software components are always installed in all
Study installations:

Sanako Study Tutor software
Installed on teacher computer

Sanako Study Server software
Installed on either server or teacher computer

Sanako Study Student software
Installed on student computers

We recommend using classroom specific server computers,
commonly the teacher computer in each class, with
individual classroom names.

However, you may also use a shared license server for
multiple classrooms. Please note that in this case the shared
license server must be running in order to use any of the
classrooms.

RECOMMENDED INSTALLATION ORDER

SanakKo

We recommend that the different components are installed in
the following order:

1. Sanako Study Server software (on server or tutor
computer)

Installation - 9



2.
3.

Sanako Study Tutor software (on tutor computer)

Sanako Study Student software (on student
computers)

INSTALLATION INSTRUCTIONS

10 -

STUDY SERVER SOFTWARE INSTALLATION

Follow the installation instructions below to install the Study
Server software.

Note: Study Server installation requires an Internet connection. If the
server computer does not have an Internet connection, you may
complete an alternative offline activation procedure. Instructions for this
can be found towards the end of this guide.

1.

2.

Sanako Study v. 5.50 Technical Guide

Select Sanako Study Server software in the
Installation CD menu to start the installation program.

Exit any other programs you have open and click Next
to continue with the installation.

i SANAKO Classroom Communication Services Setup |:||:,r>_(|

Welcome to the SANAKO
Classroom Communication
Services Installation Wizard

It iz strongly recommended that you exit all W indows programs
befare running this setup program.

Click Cancel bo quit the setup program, then close any programs
you have running.  Click Mest to continue the inztallation.

WARMING: This program is protected by copyright law and
international reaties.

Unautharized reproduction or distribution of thiz program, or any
portion of it, may rezult in zevere civil and criminal penalties, and
will be prosecuted to the masimum extent possible under law.

< Back MHext > ] [ Cancel ]

SanakKo-+
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3. Accept the license agreement and click Next.

i SANAKO Classroom Communication Services Setup EJ|E|E|
License Agreement
You must agree with the licenze agreement. below to proceed. h A
N

L
CUSTOMER LICENCE TERM3Z

The copyright and all other intellectual property rights

in this software ("the Product™) and the Documentation

are owned by the Company. Please read through the

following licence conditions before you begin

installation of the Product. If you agree to be bound by
them you may install the Product on the luthorised Muwwber
of Computers. During the installation you may be asked to
click the ACCEPT button to confirm your acceptance of the
licence conditions at which point the software will be v

(¥ | accept the license agresment
() 1 do not accept the licenze agreement

[ Reset ] [ < Back " Mext > l [ Cancel ]

4. Select a suitable installation folder and click Next.

i SANAKO Classroom Communication Services Setu p E] |E|E|
Destination Folder
Select a folder where the application will be installed. \ v
T

The installation wizard will install the files for SANARD Classroom Communication
Services in the following folder.

To install into a different folder, click the Browse button, and select another folder.

You can chooge not to install SANAKD Clasgroom Communication Services by clicking
Cancel to exit the installation wizard.

Destination Folder

C:\Program Files\SANAKDA

[ < Back " Mext > l [ Cancel

5. Select a classroom nhame.

If you will have only one Study classroom, select Yes

to use the default classroom name.

If you will have multiple Study classrooms, select No

and then enter a classroom name for the classroom in

guestion.

Note: Classroom does not refer to a physical space
here, but instead to a collection of computers in the
school network that may be used in the same Study

Installation -
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learning session.
5] SANAKO Classroom Communication Services

Select classroom communications service

Please select whether to uze the default classroom communications
service of cohnect to ahother classroom communications service.

If you have only one Study classroom in your institubion, select Yes to use the
default classroom name.

If you have multiple Study classiooms, select Mo and then enter the classroom
zervice name that was used during Study Server ingtallation for the clazsroom in
question.

Do pou want to uze the default classroom communications service?
@ “Yes [SANAKD Classroom)
I Mo
[5AMAKD Classroom

Wize Installation Wizard®

[ < Back ][ Net > ] [ Cancel ]

L

6. You can now go back and change any of your
selections or click Next to start the installation.

i SANAKO Classroom Communication Services Setup

Ready to Install the Application
Click, Mest to begin installation.

Click the Back button to reenter the installation information or click Cancel to exit
the wizard.

[ < Back " Mext > ] [ Cancel ]

7. The installation program will next ask you if this
computer will also act as the license server.

12 - Sanako Study v. 5.50 Technical Guide SanakKo-+#
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o= Study Server license settings

You can now give license if you are using this Study Server as license
server. ff you have other Study server acting as license server please
select that and give contact info of that Study Server.

@ This Study Server acts also as license server

(7) This Study Server will ask for licenses from other Study Server

License server: | 0calnost

For license server you can use any Study Server, which IP Address or
DNS name you know.

[T Enable automatic student update
Update path:

If automatic student update is enabled. Study Server will check student
version when student connects and offers an update for it i student is
older version. Works with v.5.20 and newer Study Studert applications

Apply and Close

If you only install one server for your Study system,
select the ‘This Study Server acts also as a license
server’ option.

If you have multiple server applications in your
institution, select the ‘This Study Server will ask for
licenses from other Study Server ' option and enter
the name of the computer that has been selected as
the license server.

8. Once the server installation begins, you will be
prompted for activation details, including your user
account information and your license token
information .

If you do not already have a Sanako registered user
account it can be created during installation as there
is a link to account creation in the activation details

window.
Activation Tool
Please provede actwvation details
Usor Name |RegisirEtontiame Enfier reglshered LEaT aceount
riformation Rene
User Password | Regletration Pesswd
[ To=rimiommation Enbier foken Infmmtion here

Actrvate License Cancsl

Crezte 3 reglshensd USEr account
H you giont vt an sccourd Chok Pere e =

To create a Sanako registered user account

Click click here to enter account creation. Provide
registration information to the fields and click Save to
send in your information

SanakKo-+ Installation - 13
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Registration Choose your language | English (United States) [=]

First Name

Last Name

E-mail address

it willbe used as login name
School or institution name
Street address

Optional fiekd

Postal code

Optonl fieid

City/State

Country =

¥ would like to receive Sanako news and product information to
the e-mail address specified above

I I would like to be contacted by Sanako representative

Save Cancel

You will receive your username and password to the
E-mail address provided during registration and a link
to the login page of the Sanako registration system.
Click the link to confirm your registration. Logging in is
not required at this point, but you can do so at any
time to edit your information.

9. Insert your user account and license token information
in the Activation Tool window and click Activate
License .

Activation Tool

Please provite actvabion details

Lisar Mama |Regtstrationtiame

User Password | Reglstration Pasawd

Token [ Tokeninormaticn

Actreste License Canss

W M youcont have an aocount ok Pete

10.You have now succesfully activated your software.
Store the installation ID for future use. Click OK to
continue.

@l Activation was successful.

L ¢ 4 Your InstallationID is . Please, store this ID. You may need it later,

11.0nce the installation program has finished, click
Finish to exit the installation program.

14 - Sanako Study v. 5.50 Technical Guide SanakKD-+
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SANAKO Classroom
Communication Services has
been successfully installed.

Click. the Finish button to exit this installation.

[ <Back |[Fimsh ] [ Concel |

STUDY TUTOR SOFTWARE INSTALLATION

Follow the installation instructions below to install the Study
Tutor software

1. Select Sanako Study Tutor Software in the
Installation CD menu to start the installation program.

2. Exit any other programs you have open and click Next
to continue with the installation.
i SANAKO Study 1200 Setup MISIES

Welcome to the SANAKO Study
1200 Installation Wizard

It iz strongly recommended that you exit all \Windows programs
before running this setup program.

Click Cancel to quit the zetup program, then close any programs
you have running.  Click Mest to continwe the installation.

WwWARMING: Thiz program iz protected by copyright law and
international treaties.

Unauthorized reproduction or distribution of this program, or any
portion of it, may result in zevere civil and criminal penalties, and
will be prozecuted to the maximum extent pozsible under law.

< Back L Mexst > ] [ Cancel
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i SANAKO Study 1200 Setup

License Agreement
*r'ou must agree with the licenze agreement below to proceed.

CUSTOMER LICENCE TERHMS

The copyright and all other intellectual property rights
in this software ("the Product™) and the Documentation
are owned by the Company. Please read through the
following licence conditions before you begin
installation of the Product. If you agree to he hound by
them you may install the Product on the Aduthorised Nunber
of Computers. During the installation you may he asked to
click the ACCEPT button to confirm your acceptance of the
licence conditions at which point the software will he

(33| accept the license agreement
()| do nat accept the license agreement

[ Reszet ] [ < Back " Mexst > ] [ Cancel ]

4. Under User Information , enter the name of the
system administrator and the school or institution.
Check the Anyone who uses this computer option
to make the Study application available to all users

who log in.
i SANAKO Study 1200 Setup

User Information
Enter the following information to personalize your installation.

Full Mame: |User Mame

Organization: |Instituti0n Marie

The zettings for thiz application can be installed for the current uzer or for all uzers that
share thiz computer. “Y'ou must have administrator rights to install the settings for all
users. Inztall thiz application for:

(%) Anyone who uses this computer

() Only far me (User Name)

[ < Back " Mext » ] [ Cancel ]

5. Select a suitable installation folder and click Next.
i SANAKO Study 1200 Setup Il

Destination Folder
Select a folder where the application will be installed.

The installation wizard will install the files for SaMAKO Study 1200 in the following folder.
Toinstallinto & different folder, click the Browse button, and select another folder.

“Y'ou can chooge not to ingtall SAMAKD Study 1200 by clicking Cancel to exit the
iristallation wizard.

Destination Folder

C:A\Program Files\SANAKDY

< Back " Mext » ] [ Cancel
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6. Select a classroom name.

" T ~
15 SANAKO Study Tutor Setup = e e
Select classroom communications service
Flease select whether to uze the default clazsroom communications service ar b, A
connect to another classroom communications service. N

If you have only one Study classroom in wour institution, select Yes to uze the
default classroom name.

If you have multiple Study classrooms, select Mo and then enter the classroom
zervice name that was used during Study Server installation for the classroom in
question.

Do you want to uze the default classroom communications service?
@ Yes
) No

< Back ][ Mext > | l Cancel

If you will have only one Study classroom, select Yes
to use the default classroom name.

If you will have multiple Study classrooms, select No.
At the end of the installation process you will then be
asked to select the same classroom name that was
used during the Study Server software installation for
this classroom.

Note: Classroom does not refer to a physical space
here, but instead to a collection of computers in the
school network that may be used in the same Study
learning session.

You can now go back and change any of your
selections or click Next to start the installation.

7% SANAKO Study 1200 Setup (8[=0(.3]
Ready to Install the Application
Click Mext to begin installation. h v,
N

Click the Back button to reenter the installation infarmation or click Cancel to exit
the wizard.

<Back || Newt> | [ Cancel

Installation -
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8.

Once the installation program has finished, click
Finish to exit the installation program.

i SANAKO Study 1200 Setup EE&E

SANAKO Study 1200 has been
successfully installed.

Click the Finizh button to exit this installation.

< Back Cancel

STUDY STUDENT SOFTWARE INSTALLATION

Follow the installation instructions below to install the Study
Student Software.

Note: In order to use the OneNote feature, Microsoft
OneNote must be installed on the student computers before
installing Study Student. Otherwise Study will be unable to
connect to OneNote and tutor notes cannot be sent to
students’ OneNote applications.

1.

2.

Sanako Study v. 5.50 Technical Guide

Select Sanako Study Student Software in the
Installation CD menu to start the installation program.

Exit any other programs you have open and click Next
to continue with the installation. ]
i3 SANAKO Study Student Setup A==

Welcome to the SANAKO Study
Student Installation Wizard

It iz strongly recommended that you exit all 'Windows programs
before running this setup program.

Click Cancel to quit the setup program, then cloge any programs
you have running. Click Mest to continue the installation.

WARMING: Thiz program iz protected by copyright law and
international treaties.

Unauthorized reproduction or distribution of thiz program, or any
portion of it, may result in gevere civil and criminal penalties, and
will be prozecuted to the mavimum extent possible under law.

< Back L Mext > ] [ Cancel

SanakKo+#
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You will next see a summary of what's included in the

student installation, click Next.

79 SANAKO Study Student =5

Start Installation

You are now ready to install SANAKO Study Student

Installation will

1. Install necessary prerequisites
- Wigual Studio 2008 =86 redistributable components
- Managed Direct< components
- J# 2.0 redistributable components

2. Install SAMAKD Study Student

- SAMAKD Study Student application
- Helper service

Click the Mext button to begin the installation or the Cancel button to exit.

< Back

Cancel |

%

Accept the license agreement and click Next.
it SANAKO Study Student Setup =164

License Agreement
“Y'ou must agree with the licenze agreement below to proceed.

CUSTOMEE LICENCE TERNS

The copyright and all other intellectusl property rights
in this software ("the Product™) and the Docwuwmentation
are owhed by the Company. Please read through the
following licence conditions hefore you begin
installation of the Product. If you agree to be bound by
them you may install the Product on the Authorised Number
of Computers. During the installation you may be asked to
click the ACCEPT button to confirm your acceptance of the
licence conditions at which point the software will he

(®) | accept the license agreement
(| do not accept the license agreement

[ Reset ] [ < Back " Mext > ] [ Cancel ]

Under User Information , enter the name of the
system administrator and the school or institution.
Check the Anyone who uses this computer option
to make the Study application available to all users

who log in.

i SANAKO Study Student Setup

User Information

Enter the following information to personalize your installation.

Full Mame: |User Mame

Organization: |Instituti0n Mame

The settings for this application can be installed for the current user or faor all users that
share thiz computer. Y'ou must have administrator rights to install the settings for all
uzers. [ngtall thiz application for:

(3) &nyone who uses this computer

) Only for me [User Mame]

< Back " Mext > ] [ Cancel

Installation
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6. Select a suitable installation folder and click Next.

i SANAKO Study Student Setup

Destination Folder
Select a folder where the application will be installed. g A

N
Thisg installation wizard will install the files for SAMAKD Study Student in the following
folder.

Ta install into a different folder, click the Browse button, and select anather folder.
“Y'ou can choose not to install SAMAKD Study Student by clicking Cancel to exit the
inztallation wizard.

Destination Folder

C:\Program Files\SANAKDS

[ < Back " Mext > ] [ Cancel

7. Select a classroom name.

r ~
1 SANAKO Study Student Setup = e
Select classroom communications service
Please select whether to uze the default classroom communications service or ! A
connect to another clagsroom communications service. F A

If you have only one Study clazzroom in your institution, select Yes to
use the default classroom name.

If you have multiple Study classrooms, select Mo and then enter the
clagzroom gervice name that was uged during Study Server installation
far the clagsroom in question.

Do you want to uze the default classroom communications service?

@ Yes
© No

< Back ][ Mest > ] [ Cancel

If you will have only one Study classroom, select Yes
to use the default classroom name.

If you will have multiple Study classrooms, select No.
At the end of the installation process you will then be
asked to select the same classroom name that was
used during the Study Server software installation for
this classroom.

Note: Classroom does not refer to a physical space
here, but instead to a collection of computers in the
school network that may be used in the same Study
learning session.

20 - Sanako Study v. 5.50 Technical Guide SanakKD-+



8. You can now go back and change any of your
selections or click Next to start the installation.

i SANAKO Study Student Setup

Ready to Install the Application
Click Mext to begin inztallation.
N

Click the Back button ta reenter the installation information or click. Cancel to exit
the wizard.

[ < Back ]L Mext > ] [ Cancel ]

9. Once the installation program has finished, click
Finish to exit the installation program.
i@ SANAKO Study Student Setup =13

SANAKO Study Student has
been successfully installed.

Click the Finizh button to exit this installation.

¢ Back Cancel
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STARTING STUDY

After the installation, you are ready to start Study. To start
Study Tutor, open the Windows Start menu (lower left corner
on your screen) and select Programs > Sanako > Study >
Tutor, or double-click the Study Tutor icon on the teacher
computer desktop.

SELECTING TUTOR AND CLASSROOM

After defining audio devices, you will next be asked to select
a Tutor account and a class file to open Study with. When
you start Study for the first time, select Anonymous tutor
and Empty class , since no teacher accounts or class files
have been created yet. This will start you with an empty
default classroom.

i Tutor and class selection I |

Select Tutor and Clazs from the listz below and then press OK button

Reqgistered Tutos Savedclasses

L4 Enonymous s lm

File:  Tutorl. TCF File: Tutar]l.CCF

oK Canicel

For instructions on how to create teacher accounts and class
files, see Tutor accounts and class files later in this guide.
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ADDING STUDENTS AND CREATING DEFAULT
CLASS

When you start the Tutor application for the first time, the
main window of Study opens without any student icons. You
can now add students to the classroom and create a default
class layout.

To add more student workstations to the current classroom:
1. Click on Show Corridor at the bottom of the Tutor

screen
7 Jozé 8 Bane
Talking to students @ﬁ B )
..-- ay o
“€__ ] |
1 Zheng 2 Lisa
[ | Tak |
| = | PC cantral
L Screen control

|:..= | Student application

j @ ‘wieh braveser

| | | Meszages
| lgal Chat

Show corridor | TemplateClass

2. This opens a dialog displaying all the student
computers in the classroom that are switched on.

8 Students waiting for entry to this class g@g‘
FC Mame IP address User name: Status
Studert 1 1010111 LisaG Add selected students to session
Student 2 10101.33 Hianl -
Studsnt 3 10.10.1.34 Borjes Add lo session &
Student 4 1010137 JoséG
Student 7 10.10.1.29 Emmahl
Student 9 10,0141 BeaD
Student 10 1010.1.42 LucB
Student 11 10101.43 Al
Refresh list Bemove selections  Select all
Natify me about new students in comidor by flashing "Show coridar' link
Refresh list automatically when student appears to cormidar
Close

3. Select the students you want to add and click Add to
session A , or if you want to assign them to specific
sessions, click Add selected students to session...

4. The added students are now displayed on the
classroom view.
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The Study class view is a graphical layout of your
class. Your students are displayed as student icons
that reflect their current status.

5. To save the current classroom layout as the default
class, open the File menu and then select Class file
and Save.

v
sanaxo«ili-llk File | Tools Help

Save

<5 Open Tutor Player

Save as...

N Open/Remove...
& Restart b Group Al
c
D

MOVING AND ARRANGING STUDENT ICONS

You can rearrange the student icons on the layout to
correspond with your actual classroom. Open the Tools
menu and select Admin — Move and align student icons...
to open a panel with commands for moving and arranging
student icons.

Move and Align student icons ]

Move Align Top Align Bottam Align Left Align Right

‘= lm ‘s = @ O
13 xiao 14 Jens 15 Emme 16 Mary 17 Luc 18 Al
| | | h
[-—1: rll.:: L Lo [—:: L

To move a student icon , select Move and hold your mouse
button down over the student icon.
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To align student icons , select one of the alignment options,
hold your mouse button down and drag the mouse pointer
over the student icons that you want to align.

You can also move student icons at any time by holding
down the Ctrl and Shift buttons on your keyboard and
holding your left mouse button down over a student icon.

REMOVING STUDENTS

To move a student from the class back to the corridor, right-
click a student icon and select Send to corridor . The
student can then be selected to another class by another
teacher.

To remove a student and the student icon from the class
view, right-click a student icon and select Exclude from
class (and layout) . Once the student icon is removed, the
classroom configuration can be saved as a new class.

STARTING STUDY STUDENT

SanakKo

To open the Study Student interface on a student computer,
click the Windows Start menu and select Programs —
Sanako — Study Student — Student . The teacher can also
at any time display the Student applications on student
workstations by clicking on the Student Applications button
on the Tutor interface.

Even if the Study Student application is not open on the
student screen, it is always running in the background
listening to commands from Study Tutor when the
workstation is on.
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AUDIO SETTINGS

TESTING SOUND HARDWARE COMPATIBILITY

Sanako Study includes an inbuilt application for testing
whether the sound hardware on a given computer is
compatible with Study. To test your sound hardware
compatibility, open the Tutor or Student Tools menu and
select Sound Hardware Test Wizard .

SOUND DEVICE SELECTION

Sound devices are commonly set when Study is started for
the first time.

However, you can edit Study sound device selections at any
time by selecting Sound settings in the Tools menu of
either the Tutor or Student application.

This opens the Sanako Sound Device Wizard in which you
can assign Sound devices for each Study audio function.
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When you are finished with the audio device selection, click
Save & Quit to save your settings.

SETTING SOUND DEVICE VOLUMES

Study has an inbuilt audio testing procedure in Sound
Device Wizard which allows you to identify and set default
volume levels for Study functionalities.

To test and set default volume levels
1. Click Start test

2. Follow the instructions on the screen to play sample
audio, make test recordings and define the default
volume levels for each audio device.

The default audio levels will be saved into a file which can be
deployed to all the computers in the classroom. This allows
you to equalize the audio levels for an entire classroom
without running the testing procedure separately for each
computer.

SETTING SOUND DEVICE VOLUMES FOR SANAKO
HEADSET

If you are using Sanako SLHO7 USB headsets, Study has
inbuilt default audio settings that you can easily apply.
Simply click on ‘Set Sanako Headset defaults ' to employ
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audio settings that have been preconfigured for use with a
Sanako headset.

HOW TO COPY STUDENT AUDIO SETTINGS

Sanako Study allows you to automatically equalize all the
student audio settings in a Study classroom, eliminating the
need to configure each workstation individually. To do this
you need to first carefully adjust the audio settings of one
Study player application. These settings will then be copied
to all the other player applications.

To copy student audio settings to other workstation S,
follow the instructions below.

1. Open the Tools menu in Study Tutor, select Admin
and then Student settings .

2. In the Student settings window, you need to first
select the source computer whose audio settings will
be shared. Click on Select source workstation and
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select the source computer in the drop-down list.

3. Next, check the workstations where you want to
copy the audio settings. If the settings will be copied
to the entire classroom, click to select all
workstations.

4. Once you have selected the target workstations, click
Copy settings , the workstation list on the left will
indicate when the copying is ready.

5. When the settings have been copied to the desired
workstations, click Close to exit the settings window.

USING A MEDIA PLAYER AS SOURCE

If a Media Player application is used as the media source in
Study, ‘overlays’ need to be disabled in the media player.

To disable overlays in Windows Media Player, select More
Options under Library . In the Options window, select the
Performance tab and click Advanced under Video
Acceleration . In the Video Acceleration Settings  window
unselect the Use overlays option.

WINDOWS VISTA SPECIFIC SETTINGS

In Windows Vista environments, Stereo Mix needs to be
displayed and enabled in the Vista Recording Devices in
order to use CD audio and the Tutor player.
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To do this, right-click the speaker icon in the lower-right
corner of the Windows Vista toolbar and select Recording
Devices . In the Sound dialog, select the Recording tab,
right-click the devices list and select Show Disabled
Devices . Enable the Stereo Mix device that appears on the
list.

SETTING DATA PROPERTIES FOR SAVED
AUDIO FILES

To set data properties for saved student recordings, open the
Student Tools menu and then select Settings .
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CONFIGURING FOLDERS

SanakKo

Many Study functionalities require that you define a default
file folder for them where functionality specific files are then
stored. All these folders can be configured in Study Tutor
Preferences. To edit default folders, open the Study Tools
menu, select Preferences and then the Tutor tab.

It is recommended that all these folders are located in a
separate file server, However, the Tutor’s class directory
folder can also be located on the local teacher computer.

Configuring folders -
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The table below provides information on the folders and their

access rights:

Folder

Purpose Of The Folder

Teacher Access
Required

Student Access
Required

Tutor’s class directory

Storage area for
teacher’s class files

Read/Write/Modify

No Access Required

Student files collection
folder

Collecting student
recordings

Read/Modify

Hidden Write

Session and content
files folder

Sharing teaching
content. Subfolders for
sessions A,B,C,D,E,F
and Tutor will be
created under this folder

Read/Write/Modify

Read

Media files folder

Storage area for
different media source
files, which can be used
during teaching
activities

Read/Write/Modify

Read

Web policy files folder

Saving Web policy files,
which are used during
the Web browsing
activity

Read/Write/Modify

No Access Required

Application list files
folder

Storage area for lists of
denied and allowed
applications which are
used in the Block
applications function

Read/Write/Modify

No Access Required

Document files folder

Storage area for
document files which
are used during the
reading practice activity

Read/Write/Modify

Read

Exam test files folder*

Storage area for exam
files, which are used
during the Exam activity

Read/Write/Modify

Read

Exam result files
collection folder*

Collecting exam result
files from students
during the Exam activity

Read/Modify

Hidden Write

*These folders are needed only if Sanako Study Examination Module has

been installed
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TUTOR ACCOUNTS AND CLASS

FILES

SanakKo

The purpose of tutor accounts and class files is to allow each
teacher to start the system with their own default settings
and with a pre-set classroom layout for each different course,
if needed.

Each teacher has a personal tutor configuration file with their
preferences but can employ multiple class files. When
teachers open the Study Tutor application they need to
select their own tutor name and the class file that they want
to use.

ADDING A NEW TUTOR

In order to add a new tutor to Study, open the Tools menu
and then select Admin and Add/Remove Tutors...

You can now enter a new tutor name that will be available
when logging into the Study Tutor application. To set the
folder where the new tutor’s class files are saved, click on
the Browse button.
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After a new tutor has been added to the system, a tutor
specific Tutor Configuration File (.TCF) is created
automatically by the system.

When you have entered a tutor name and defined a folder for
the tutor’s class files, click on Save and then exit the Study
application. When the Study application is restarted, the new
tutor name is available in the log in window.

DISABLING TUTOR LOGIN

If you do not want to use personal tutor accounts, you can
disable tutor login. This means that Study will simply be
opened with the default classroom layout and tutor settings
every time.
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To disable Tutor login, go to Tools > Preferences > Login
tab and uncheck the Request Tutor login at start-up
option.

CLASS FILES

Class files include the classroom layout , student names |,
sessions and default activities

Each Tutor can own multiple personal class files (.CCF) and
can select which class file they want to use when logging in.

Tutors can also manually open, save and remove class files
by opening the File menu and selecting Class file .
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CREATING A NEW CLASS FILE

To save the current classroom settings as a new class file,
open the File menu and select Class file > Save.

This opens a window where you can name the class file and
then save it. If you save the file as a Template Class File ,
the class file will be available for all tutors when they log in.

If changes have been made to the classroom settings during
a lesson, Study will automatically ask you whether you want
to save the changes to the current class file when the Tutor

application is closed.

SAVE LOCATION FOR CLASS FILES (.CCF)

To set the location where the Class Files are saved, open
the Tools menu and select Preferences and then the Tutor
tab.
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TUTOR SPECIFIC SETTINGS

Tutor configuration files contain the personal settings of each
tutor, including:
- Tutor name

Save folder for class files (.CCF)

Interface language selection

Session file folder

Student file collection folder

Program shortcuts for application launch

Last used class file

Auto scan interval

Auto scan order

Thumbnalil size

Each tutor has their own Tutor configuration file (. TCF) which
is created when a new tutor is added into Sanako Study.

Most Tutor specific settings are available under the Tutor tab
in the Tutor application Preferences . To open the
Preferences window, start the Tutor application and then
open the Tools menu and select Preferences .
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APPLICATION LANGUAGE

Determine the Tutor interface language. The default
selection for the interface language is English. Additional
interface languages can be selected in the drop down menu.

AUTOSCAN

Set the default time that each student screen is displayed
during the autoscan function and select the order in which
the student screens will be shown.

THUMBNAIL SIZE

Use the slider to determine the size of thumbnail images of
student screens.

To view thumbnail images of student screens either in place
of the student icons or in a separate window, click the
Screen Control button and select either Thumbnails or
Thumbnails in separate window
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GENERAL SETTINGS

GENERAL SETTINGS

You can set general settings for different Study functions in
the Settings tab of the Tutor Preferences window.
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ACTIVITY

AP Exam — Select whether the AP Exam activity is displayed
in the Activity selection list in the Tutor application.

TEMA4 Oral test — Select whether the TEM4 Oral test activity
is displayed in the Activity selection list in the Tutor
application.

TEMS8 Oral test — Select whether the TEM8 Oral test activity
is displayed in the Activity selection list in the Tutor
application.

Tutoring — Select whether to minimize the Tutor application
when the Tutoring activity is started and the Tutor screen is
transferred to students.

AUDIO

Stream Tutor media files means that when a file is used as
the audio source to students, the audio is sent as a VOIP
stream instead of the students opening the file.

There are two different ways of monitoring student audio in
Study:

If Stream the student media file while monitoring is
selected, the student audio is streamed to the teacher as a
VOIP stream during monitoring. The teacher will hear the
student’s microphone and any media file that the student
may be listening to.

Note: Student microphone cannot be monitored during an
activity, if the media source is Tutor player, CD audio or an
External source.

If Monitor input line is selected the mixer audio lines are
monitored and you can choose what you'll be able to hear
when monitoring students. Stereomix allows you to hear
whatever the student hears. Microphone means you will
hear the student microphone during monitoring.

Note: Regardless of the selected option, if students are
monitored while they are recording their voice, only the
student voice can be heard.

The Tutor Player option allows you to select the default
Tutor media player, which can then be used as a media
source during the different Study activities.

FILE DISTRIBUTION

Checking the Allow file transfer from local folders option
will allow the teacher to copy and launch files to students
from any local folder. The students do not need access rights
to the folder, since the launched file will be copied to the
student computer. This will also apply when a file in a local
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folder has been selected as the media source and when the
copy and launch function is used with a file in a session file
area.

Default file type allows you to select the default file format
that is used for collected student recordings.

INTERNET

The Internet options allow you to block Internet ports and
Web browsers.

Enable internet blocking allows the teacher to use the
Disable Internet function in the Tutor application PC Control
features to disable all Internet traffic on student computers.

Block other browsers during Web activities allows the
Web browser applications opened by the teacher, but
prevents students from opening any other browser
applications.

SCREEN TRANSFER

The Screen Transfer settings apply when a Tutor or Student
screen is shared to others.

THUMBNAIL / SNAPSHOT

Set the default time for updating thumbnails and snapshots
of student screens.

WLAN

Disabling screen transfer operations  will deactivate all
screen transfer features in Study. This is beneficial in
wireless environments where using the screen transfer
operations could slow the system down.

Network connection type allows you to define the type of
network Study is used in. This helps the program configure
itself for optimal performance.

IDENTIFYING STUDENTS

DEFAULT STUDENT NAMES

You can choose a default option for naming students in the
Study classroom view in Tutor Preferences in the Login tab.
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All students that join a classroom are automatically named
according to the selection made here. However, loading a

saved class file will instead use the names saved in the class
file.

IDENTIFYING STUDENT COMPUTERS

You can choose a default option for identifying individual
student computers that join the Study classroom in Tutor
Preferences in the Login tab.

There are two options for identifying student computers that
will be added into a Study classroom.
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Student PC name (default option) will identify all
computers with a different computer name as
individual students and add a new student icon for
each student computer. This is the recommended
setting in all environments where students operate
individual student computers.

Student User name will add a student icon for each
different student login name that enters the Study
classroom. This setting is usually only used in settings
where multiple students share a workstation.

SYSTEM CONFIGURATION
SETTINGS

Sanako Study system configuration settings allow you to
View available licenses
Edit classroom selections
Set password protection for the Tutor application
Change your installation type

To access system configuration settings, open the Tools
menu in Study Tutor and select Preferences . In the
preferences window select the System tab, click the Change
system configuration settings  button and click OK.
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This opens a Sanako Study configuration window where you
can manage the above information.

LICENSE QUERY

Study asks you to enter your license information during the
Study Server application installation. Depending on your
license information, you can select which Study version to
qguery from the Study Server

CHANGING ACTIVE PRODUCT LICENSE

1. In the Sanako Study configuration window, select
Product licensing and then choose which license to
qguery from the server.
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EDITING CLASSROOM NAMES AFTER INSTALLATION

The classroom that Study computers belong to is set during
the installation. However, you can change the classroom
affiliations of tutor and student applications after the
installation.

To change the Tutor application classroom , select
Classroom selection in the Sanako Study configuration
window, and then click Change... .

To change the Student application classroom , open
Windows Explorer, go to the Program Files / Sanako /
Study / Student folder and run the SetClassroom.exe
application. Running SetClassroom.exe opens a dialog
where you can select a new classroom in a drop-down
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menu.

PASSWORD PROTECTION FOR STUDY TUTOR

If needed, you may set a password for the Study Tutor
application. Password protection is normally only used in
instances where the same workstation is used both as a
teacher and student computer. Most commonly this occurs in
multipoint server environments (see ‘Installation type’ below)

To enable password protection for the Study Tutor
application, select Password protection , check the
Password protected option and then click Change to enter
a new password. This password will then be requested every
time the Tutor application is started.

INSTALLATION TYPE

Teachers and students most often have their own separate
computers in a Study setup. However, in case of different
configurations where Installation type allows you to define
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your system configuration in special cases where you either
have student pairs sharing workstations or employ shared
computing resources in the classroom.

Standard installation
This is the default option in which teachers and students all
use their own computers.

Multistudent installation
Select this option if you have two students sharing student
workstations.

Windows MultiPoint installation

Select this option if the system is installed onto a Windows
MultiPoint setup where the teacher and students are
connected to the same resource with thin clients.
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STUDY SYSTEM LOGS

LOG FILE OPTIONS AND TUTOR LOG FILES

The System tab in Study Preferences allows you to access
log files in which Sanako Study automatically makes a record
of the activity in the system. You can choose whether to
employ standard logging or extended logging, which
creates more detailed log files.

There are also separate student log files recording the
activity on each student computer. For instructions on how to
access them, see below.

REMOVING STUDENT LOG FILES

To remove student log files, you need to access the Student
settings window. Open the Tools menu, select Admin and
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then Student settings .

1. Inthe Student settings window, select the
Temporary files tab.

2. Check the student computers where you want to
remove log files, or click to select all students.

3. Check the Remove current log files option

4. Click Remove files . The student log files are now
deleted.

COLLECTING STUDENT LOG FILES

To collect student log files, you need to access the Student
settings window. Open the Tools menu, select Admin and
then Student settings .

1. Inthe Student settings window, select the Log files
tab.

2. Check the student computers where you want to
collect log files, or click to select all students.
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3. Check the Collect Tutor and client logs  option

4. Click Collect log files . The student log files are now
collected to the location defined in Study Preferences.
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VIEWING PRODUCT
INFORMATION

Open the Tutor or Student Help menu and select About to
open a window displaying product information, your software
version, and the Study modules that you have installed.
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SANAKO STUDY OFFLINE
ACTIVATION

WHAT IS OFFLINE ACTIVATION?

Instead of a printed product license, Sanako Study
customers receive a license activation token by email. The
token is entered during Study Server software installation to
activate the software license. However, the activation
process requires that you have an active Internet connection.

In case the computer where you are installing Study Server
software does not have an Internet connection, you may
complete an offline activation process in order to finalize
your installation.

Please note that part of the offline activation process needs
to be performed on a computer with an Internet connection.
This computer may be located anywhere.

WHAT IS REQUIRED FOR OFFLINE ACTIVATION?

Sanako Study software
USB flash drive
Teacher/Server computer (offline)

Computer with Internet connection (may be located
anywhere)

HOW TO COMPLETE AN OFFLINE ACTIVATION

The offline activation process of a Study license has three
parts.

Software installation and creation of a license request
file

User account registration and creation of license
activation file
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Activation of Study license token

SOFTWARE INSTALLATION AND CREATION OF
A LICENSE REQUEST FILE

1. Start and proceed through Study software installation
normally on the offline computer. More detailed
instructions are available in the Sanako Study
Technical Guide delivered along with your software.

2. During the installation, the installation program will
inform you that the computer has no Internet
connection and therefore the license could not be
activated.

Click NO to initiate the offline activation process

3. The program will next ask you if you already have a
ready license file or need to create one.

At this point we do not have our license file yet, so
click NO.

Sanako Study v. 5.50 Technical Guide SanakKo-+



4. Enter your Study license token information and click
OK.

5. The installation program will now ask you where to
save a ‘license request (.req) file’. Enter your USB
flash drive, click Save request and save the file onto
the USB device

6. Click Finish to finish the software installation

We have now installed the Study Server software and saved
a ‘license request file’ onto a USB flash drive. Before the
Study software can be used, you need to register a user
account and acquire a ‘license activation file’. The next part
will explain how this is done.
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USER ACCOUNT REGISTRATION AND
CREATION OF LICENSE ACTIVATION FILE

Before the installed software can be used, you need to log
on to the Sanako online registration site, create a user
account and then use the ‘license request file’ to download a
‘license activation file’.

7. Take the USB flash drive with the ‘license request file’
to any computer with an Internet connection

8. Open an Internet browser and go to the Sanako
registration site at the following address
http://registration.sanako.com/tokens

9. Click Registration to create a Sanako user account

If you already have an active user account, simply
enter your details and skip items 10 and 11 in the
instructions below.

10. Enter your information in the registration window and
then click Save

11.You will receive your username and password to the
email address provided during registration and a link
to the login page of the Sanako registration site.
Follow the link to the login page to confirm your
registration and then log in to the Sanako registration
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site.

12.In the Sanako registration site, select the Off-line
activation tab and click Browse .

13.Locate and select the ‘license request file’ on the USB
flash drive. The off-line activation tool will now
download a ‘license activation (.xml) file’. Save the
‘license activation file’ onto the USB flash drive

Next, you need to go back to the offline computer where
Study Server is installed and activate the license on the
computer with the ‘license activation file’ on your USB
device.

ACTIVATION OF STUDY LICENSE TOKEN

When you have downloaded a ‘license activation file’ onto
your USB flash drive, the final part of the offline activation
process is activating the license token on the offline
computer.

14.Enter the USB flash drive onto the Study Server
computer and select Start — All Programs — Sanako
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— Activate Study Token

15.The message informing you that the computer has no
Internet connection appears again. Click NO to
continue with offline activation

16.The program will next ask you if you already have a
ready license file or need to create one.

Click YES and then locate and select the ‘license
activation file’ on the USB flash drive

17.You have now completed the offline license activation.
Store your installation ID number for later use

When the activation has been completed, you can proceed
with Tutor and Student software installations.

Sanako Study v. 5.50 Technical Guide SanakKo-+



INSTALLING FROM MSI
PACKAGES

PRE-REQUISITES FOR MSI INSTALLATION

If you want to install Sanako Study using MSI packages,
please check that the following requirements are met to
ensure a successful installation.

Installing Study with MSI packages requires that DirectX 9.0c
and Microsoft .NET Framework 2.0 SP2 or later have been
installed onto the computer before installing any of the MSI
packages.

Additionally, the following packages must also be installed
onto the computer to ensure successful execution of the
programs:

mdxredist.msi — Installs DirectX managed extensions

jsredist.msi — Installs J# version 1.1 runtimes (for XP,
Microsoft .NET Framework 1.1 required)

vjredist.exe — Installs J# version 2 runtimes (for Vista)

The .exe Study installation package includes the above
components. If the .exe Study installer is used, only .NET
Framework needs to be installed beforehand.
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EXTENSION MODULES

ADDING EXTENSION MODULES

In order to add extension modules, you will need a new
software license. To add an extension module, open the
Study Tutor Tools menu, select Preferences and then the
License tab. Click Change basic module license and then
enter your new software license. The extension modules
included in your license are now available.
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ADDITIONAL INFORMATION

SanakKo+

You can find additional information on the installation and
configuring of Sanako Study in the Sanako Study 500, 700
and 1200 Knowledge Bases. These are available in the
Support section of the Sanako Web site.

http://www.sanako.com/Support.iw3

The Study 500, 700 and 1200 Knowledge Bases include
several technical documents that may be useful when
installing and configuring your Study system:

Additional information -
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